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Cronologia delle modifiche

1 Cronologia delle modifiche
Le modifiche menzionate nell'elenco seguente sono cumulative.

Changes in V3R2 FR1

Capitoli modificati Descrizione delle modifiche

Prime operazioni alla pagina 15

Configuration by the myReports Administrator alla
pagina 33

myReports User Roles alla pagina 42

myReports administrators can no longer configure the
e-mail account to be used for sending reports via e-
mail

Modifiche in V2R7

Capitoli modificati Descrizione delle modifiche

Come installare myReports Aggiornamento della procedura d'installazione
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Con questa documentazione
Tipi di argomenti

2 Con questa documentazione
Qui sono riportate informazioni introduttive su questa documentazione.

2.1 Tipi di argomenti

Gli argomenti trattati includono concetti e istruzioni per l'uso.

Tipo di
argomento

Indice Titolo

Concept Spiega "Cosa". senza verbo
come in Elementi
dell'interfaccia utente o
con un gerundio come
in Installazione e avvio
di myReports.

Istruzioni per
l'uso

Descrivono passo per passo
i casi di applicazioni orientati
sulle attività – ad es. "Come"– e
presuppone la conoscenza dei
relativi concetti.

Inizia con "Come"
seguito da un verbo,
come in Come
aggiungere un modello
di rapporto.

2.2 Convenzioni di visualizzazione/rappresentazione

La presente documentazione utilizza diverse convenzioni per rappresentare i
vari tipi di informazioni.

Tipo di informazioni Aspetto Esempio

Elementi dell'interfaccia
utente

grassetto Fare clic su OK.

Percorsi di menu > File > Fine

Aspetti particolarmente
importanti

grassetto Il Nome non può essere
eliminato.

Testo dei riferimenti
incrociati

corsivo Ulteriori informazioni
sono disponibili
nell'argomento Rete.

Versione Tipo di carattere con
spaziatura fissa, ad es.
Courier

Comando non
trovato.

Input Tipo di carattere con
spaziatura fissa, ad es.
Courier

Immettere LOCAL
come nome file.

Combinazioni di tasti Tipo di carattere con
spaziatura fissa, ad es.
Courier

<Ctrl>+<Alt>+<Esc>
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Introduzione
myReports

3 Introduzione
Questo documento si rivolge all'utilizzatore di myReports e descrive le
procedure di installazione, configurazione e uso.

3.1 myReports

myReports è un'applicazione che consente di creare rapporti sugli agenti del
Contact Center e sulla relativa attività, nonché su chiamate, code d'attesa,
prestazioni, livello di servizio e codici di post-elaborazione.

myReports offre i seguenti servizi: 

• Più di 100 modelli predefiniti e suddivisi per temi (gruppi di rapporti) da
utilizzare per la creazione di rapporti

• Pianificazioni per la creazione di rapporti programmabili nel tempo
• Invio immediato e programmabile di rapporti tramite e-mail
• Esportazione di rapporti pianificati
• Formati di output per l'anteprima del rapporto, l'invio tramite e-mail e

l'esportazione dei rapporti: Excel, PDF e Word
• Anteprima rapporto, per la verifica del rapporto da creare nel formato di

output desiderato.

Backup e ripristina

Per il salvataggio e il ripristino delle informazioni del sistema di comunicazione,
vengono presi in considerazione anche i rapporti e le pianificazioni di
myReports.

3.2 Elementi dell'interfaccia utente

L'interfaccia utente di myReports è costituita dalla finestra principale con
diverse aree.

La finestra principale è composta dai seguenti elementi: 
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• Barra dei menu (1) con i menu:

– File
– Amministrazione
– Guida

e al nome dell'utente registrato.

Le opzioni dei menu possono essere richiamate con i tasti di scelta rapida a
destra, accanto alle voci stesse.

• Menu funzioni (2) con le icone:

Icona Funzione

Gestione pianificazione

Gestione rapporti

Le mie pianificazioni

• Gestione rapporti (3): solo in combinazione con Gestione pianificazione

Contiene tutti i modelli di rapporti ordinati in una struttura ad albero e
raggruppati in base al contenuto.

• Area di lavoro (4): solo in combinazione con Gestione pianificazione

Icona Funzione

Parametri rapporto

La visualizzazione di altre icone dipende dalla funzione selezionata.
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Introduzione

• Barra di stato (5) con informazioni su

– Stato connessione al server applicazioni.
– Data e Ora.

Descrizioni

Le descrizioni sono piccole finestre con le quali myReports visualizza altre
informazioni su oggetti specifici dell'interfaccia utente grafica, ad esempio le
icone. Le descrizioni vengono visualizzate restando col puntatore del mouse su
un oggetto per un certo tempo.

Concetti correlati
Rapporti alla pagina 16
Pianificazioni alla pagina 23

A31003-P3030-U129-03-7219, 05/2024
myReports, Manuale d'uso 9



Installazione e avvio di myReports
Come installare myReports

4 Installazione e avvio di myReports
In questa sezione vengono fornite informazioni sui requisiti hardware e software
di myReports, sulle procedure di installazione e di avvio di myReports e sugli
aggiornamenti e gli upgrade.

Nota:  Rispettare scrupolosamente le indicazioni contenute nel
file Readme first che si trova nella stessa cartella del file di
installazione.

Password

La password vale per myReports, myAgent, myAttendant,
myPortal for Desktop, myPortal for Outlook e Fax Printer nonché per l'accesso
telefonico alla casella vocale.

Non è possibile modificare la password in myReports, ma solo in myAgent,
myAttendant, myPortal for Desktop e myPortal for Outlook o tramite il menu
telefonico della casella vocale.

Licenze

La licenza consente l'installazione parallela di myReports per più utenti. Solo un
utente per volta può utilizzare myReports.

Cambio dell'utente

È possibile cambiare utente senza uscire da myReports.

Registrazione automatica

È possibile utilizzare la registrazione automatica se si desidera avviare
myReports senza dover accedere tramite la finestra di registrazione.

Nota:  Utilizzare la registrazione automatica solo se è possibile
escludere che altre persone abbiano accesso al proprio account
Windows. In caso contrario, tali persone potrebbero accedere
ai vostri messaggi vocali o fax o deviare il vostro numero di
telefono su destinazioni esterne a pagamento.

4.1 Come installare myReports

Prerequisiti

L'account utente Windows ha i diritti di amministrazione locale per
l’installazione. 

Il file di installazione è disponibile.

Suggerimento:  Rispettare scrupolosamente le indicazioni
contenute nel file ReadMe first.
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Installazione e avvio di myReports
Come avviare myReports

Passo a passo

1) Eseguire il file di installazione CommunicationsClients.exe.
2) Quando viene visualizzata la finestra Controllo account utente unitamente

al messaggio Tentativo da parte di un programma non
identificato di accedere al computer,, fare clic su Consenti.

3) Inserire l’indirizzo IP fornito dal proprio amministratore e fare clic su Avanti.
4) Dopo la validazione dell’indirizzo IP, il programma di installazione verificherà

se .NET 4.5 è disponibile e, in caso negativo, lo installerà.
5) Fare clic su myReports per installarlo.

Facendo clic su un’applicazione, si passa ciclicamente tra le azioni:

Icona Funzione

Installa

Ripristina

Rimuovi

6) Se lo si desidera, modificare la cartella di installazione nel campo Installa
su:.

7) Fare clic su Installa.
8) Seguire le ulteriori istruzioni fornite dal programma di installazione.

Passaggi successivi

Attivare la licenza per myReports.

Attività correlate
Come avviare myReports alla pagina 11
Come disinstallare myReports alla pagina 13

4.2 Come avviare myReports

Prerequisiti

Un agente del Contact Center può avere il livello di autorizzazione Supervisore
o Amministratore. 

myReports è installato sul PC dell'utente.

È stata attivata la licenza per myReports.

myReports non è stato avviato da nessun altro utente.

Passo a passo

1) Fare clic su Start  > Programmi > Communications Client > myReports.
Al termine verrà visualizzata la finestra di registrazione.

2) Nel campo Nome utente, immettere il proprio nome utente. Questo
normalmente corrisponde al numero di telefono dell'utente. Per chiarimenti
rivolgersi all'amministratore del proprio sistema di comunicazione.

3) Nel campo Password, inserire la propria password composta
esclusivamente da cifre. La password predefinita per il primo accesso è
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Come cambiare l'utente

1234. Per chiarimenti rivolgersi all'amministratore del proprio sistema di
comunicazione.

Nota:  Dopo cinque tentativi errati di inserimento della
password, l'accesso a tutti i client del Contact Center
e UC Suite viene bloccato. Lo sblocco può essere
eseguito esclusivamente dall'amministratore del sistema di
comunicazione.

4) Se in futuro si desidera utilizzare la funzione di registrazione automatica
in myReports, selezionare la casella di controllo Salva password. Sarà
sempre possibile modificare successivamente questa opzione, vedere Come
disattivare la registrazione automatica alla pagina 12.

Nota:  Utilizzare la registrazione automatica solo se è
possibile escludere che altre persone abbiano accesso al
proprio account Windows. In caso contrario, tali persone
potrebbero accedere ai vostri messaggi vocali o fax o
deviare il vostro numero di telefono su destinazioni esterne a
pagamento.

5) Inserire nel campo Indirizzo IP l'indirizzo IP del proprio server applicazioni,
se questo non viene già visualizzato.

6) Fare clic su Connetti.

Attività correlate
Come installare myReports alla pagina 10
Come cambiare l'utente alla pagina 12
Come disattivare la registrazione automatica alla pagina 12

4.3 Come cambiare l'utente

Prerequisiti

myReports è stato avviato.

Passo a passo

1) Fare clic su File > Disconnetti. Viene visualizzata la finestra di
registrazione.

2) Accedere al sistema (vedere Come avviare myReports alla pagina 11, dal
punto 2).

Attività correlate
Come avviare myReports alla pagina 11

4.4 Come disattivare la registrazione automatica

Prerequisiti

myReports è stato avviato. 
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Come disinstallare myReports

Passo a passo

1) Fare clic su File > Disconnetti. Viene visualizzata la finestra di
registrazione.

2) Deselezionare la casella di controllo Salva password.
3) Accedere al sistema (vedere Come avviare myReports alla pagina 11, dal

punto 2).

Attività correlate
Come avviare myReports alla pagina 11

4.5 Come disinstallare myReports

Passo a passo

1) Chiudere myReports. 

Nota:  Rispettare scrupolosamente le indicazioni contenute
nel file ReadMe First.

2) Selezionare una delle seguenti opzioni:

• Windows XP: nel Pannello di controllo, fare clic su Software.

Fare clic sulla voce myReports, quindi su Rimuovi.
• Windows Vista: nel Pannello di controllo, fare doppio clic suProgrammi

e funzionalità.

Nel menu di scelta rapida della voce myReports, fare clic su Disinstalla.
• Windows 7: in Pannello di controllo, fare clic su Programmi.

Fare clic su Programmi e funzioni.

Nel menu di scelta rapida della voce myReports, fare clic su Disinstalla.
3) Seguire le ulteriori istruzioni fornite dal programma di disinstallazione.

Attività correlate
Come installare myReports alla pagina 10

4.6 Aggiornamenti automatici

Gli aggiornamenti automatici assicurano che myReports venga mantenuto alla
versione più recente disponibile.

Se myReports rileva che sul server applicazioni è presente una versione più
recente, viene visualizzato un messaggio corrispondente. Alla chiusura di
myReports viene eseguito l'aggiornamento automatico.
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4.6.1 Come eseguire l'aggiornamento automatico

Prerequisiti

L'utente ha un ricevuto un messaggio come: Client update available.
Please wait while the update is done. Please close the
following programs to continue the update: [...].

Passo a passo

Chiudere i programmi citati.

Passaggi successivi

Dopo l'aggiornamento automatico riavviare myReports.
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Prime operazioni
Come selezionare la lingua dell'interfaccia utente

5 Prime operazioni
Prime operazioni descrive le attività che si consiglia di eseguire all'inizio.

Select the language

Select the language of the user interface of myReports.

5.1 Come selezionare la lingua dell'interfaccia utente

Passo a passo

1) Fare clic su Amministrazione > Impostazioni myReports. 
2) Nell'elenco a discesa Lingua selezionare la lingua desiderata.
3) Fare clic su Salva.
4) Fare clic su File > Disconnetti. Viene visualizzata la finestra di

registrazione.
5) Accedere al sistema (vedere Come avviare myReports alla pagina 11, dal

punto 2).
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6 Rapporti
In qualità di utente myReports, è possibile creare rapporti sugli agenti Contact
Center e sulle relative attività, incluse chiamate, code d'attesa, prestazioni,
livello di servizio e codici di elaborazione.

I rapporti possono essere creati da ca. 100 modelli di rapporti predefiniti
suddivisi per temi (gruppi di rapporti).

Suggerimento:  Si consiglia di non creare rapporti con più di
100 pagine. Se necessario, il periodo del rapporto dovrebbe
essere limitato di conseguenza.

Cronologia chiamate

I rapporti si basano sulla cronologia chiamate salvata nel sistema di
comunicazione. Il massimo tempo di conservazione della cronologia chiamate
corrisponde a 365 giorni (impostazione predefinita). L'amministratore del
sistema di comunicazione può definire il tempo di conservazione della
cronologia chiamate a livello di sistema.

Esempio: il tempo di conservazione è stato impostato su 100 giorni. Per la
creazione di rapporti, è pertanto possibile accedere ai dati storici relativi al
massimo ai 100 giorni precedenti.

Lingua

I rapporti vengono creati nella lingua dell'interfaccia utente di myReports.

Parametri rapporto

Prima della creazione di un rapporto, definire, utilizzando i parametri rapporto,
il periodo di tempo (data, ora) e l'argomento (agenti, code d'attesa, ecc.) su cui
dovrà essere basato il rapporto.

Sono disponibili i seguenti parametri rapporto:

• Dal

Data di inizio del periodo del rapporto
• Al

Data di fine del periodo del rapporto
• Ora "Da"

Ora di inizio del periodo del rapporto
• Ora "A"

Ora di fine del periodo del rapporto
• Nome coda

Coda rilevante per il rapporto
• Code

Code rilevanti per il rapporto
• Agente

Agente rilevante per il rapporto
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• Agenti

Agenti rilevanti per il rapporto
• Utente

Utenti interni rilevanti per il rapporto
• CLI

Numero di telefono di un utente esterno (cliente) rilevante per il rapporto
• Frammento CLI

Parte del numero di telefono degli utenti esterni (clienti) rilevante per il
rapporto

• ID cliente

ID cliente rilevante per il rapporto
• Descrizione post-elaborazione

Codice di post-elaborazione rilevante per il rapporto
• Gruppo post-elaborazione

Gruppo di post-elaborazione rilevante per il rapporto
• Solo orario d'ufficio

Questa opzione tiene conto solo dell'orario d'ufficio configurato nel WBM.
• Rapporto giornaliero

Questa opzione organizza i risultati del rapporto su base giornaliera.

Formati di output

È possibile scegliere tra i seguenti formati di output per l'anteprima del rapporto
e per l'invio di rapporti tramite posta elettronica istantanea:

• Excel
• PDF
• Word

Si tenga presente che una rappresentazione grafica dei risultati del rapporto
non è possibile nei formati di output di Excel.

Protezione dei dati

Durante la configurazione di myReports, l'amministratore di myReports può
attivare la protezione dei dati. In tal caso, in tutti i rapporti le ultime quattro cifre
del numero di telefono (colonna CLI) verranno sostituite da ****.

Se un utente ha impostato il proprio numero abitazione, numero cellulare,
numero di telefono esterno 1 e/o numero di telefono esterno 2 come non
visibile, nei rapporti non verranno mostrati tali numeri.

Gestione rapporti

Gestione rapporti viene utilizzato per gestire i modelli di rapporti. Mostra un
elenco di tutti i modelli di rapporti con i seguenti dettagli:

• ID
• Nome rapporto
• Gruppo rapporto
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Modelli di rapporti predefiniti

È possibile ordinare i modelli di rapporti in base ai valori alfanumerici di
una qualsiasi colonna, in ordine crescente o decrescente. Inoltre, Gestione
rapporti include un elenco a discesa per la selezione dei gruppi di rapporti
visualizzati, una visualizzazione che indica il numero di modelli di rapporti e le
seguenti icone:

Icona Funzione

Aggiorna

Elimina rapporto

Seleziona file

Aggiungi rapporto

È possibile anche creare gruppi di rapporti aggiuntivi e archiviarli in Gestione
rapporti.

Anteprima rapporto

Se lo si desidera, è possibile creare un'anteprima del rapporto in uno dei formati
di output e salvarla o aprirla immediatamente con l'applicazione appropriata.

Consegna immediata tramite e-mail

È possibile inviare un rapporto tramite e-mail come allegato al destinatario
desiderato. L'oggetto dell'e-mail inizia sempre con il cognome dell'utente
e il relativo indirizzo e-mail configurato nel sistema di comunicazione. Se
necessario, si può anche aggiungere altro testo nella riga dell'oggetto.

Rapporti predefiniti

I modelli di rapporti predefiniti possono essere modificati da un amministratore
di myReports.

Nota:  Tenere presente che tutte le pianificazioni vengono
eliminate quando si aggiornano i modelli di rapporti predefiniti.

Concetti correlati
Elementi dell'interfaccia utente alla pagina 7
Pianificazioni alla pagina 23

6.1 Modelli di rapporti predefiniti

myReports mette a disposizione circa 100 modelli di rapporti predefiniti per la
creazione di rapporti.
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Come visualizzare l'anteprima del rapporto

Questi modelli sono suddivisi nei seguenti temi (gruppi di rapporti): 

• Attività agente
• Agenti
• CLI
• Cronologia chiamate
• Chiamate
• Fax/e-mail
• Altro
• Prestazioni
• Code
• Stato presenza utente
• Codici post-elaborazione

Suggerimento:  I modelli di rapporti predefiniti non possono
essere modificati da un utente myReports.

Aggiornare i modelli di rapporti predefiniti

A seguito di un aggiornamento del software applicativo myReports,
potrebbero essere disponibili nuovi modelli di rapporti predefiniti. In qualità
di amministratore di myReports, è possibile aggiornare i modelli di rapporti
predefiniti e quindi rendere disponibili i nuovi modelli a tutti gli utenti myReports.

Nota:  All'aggiornamento dei report predefiniti, tutte le
pianificazioni vengono eliminate.

Attività correlate
Come aggiornare i modelli di rapporto predefiniti alla pagina 21

6.2 Come visualizzare l'anteprima del rapporto

Prerequisiti

I prefissi per numeri di telefono esterni sono stati configurati. 

Passo a passo

1) Fare clic su Gestione pianificazione.
2) In Gestione rapporti, nel gruppo rapporti corrispondente, fare clic sul modello

di rapporto desiderato.
3) Utilizzando i parametri rapporto, definire il periodo di tempo e l'argomento su

cui dovrà essere basato il rapporto.

Suggerimento:  I parametri rapporto dipendono dal modello
di rapporto scelto. Per informazioni sui vari parametri
rapporto, consultare la sezione Rapporti alla pagina 16.

4) Fare clic su OK, quindi di nuovo su OK.
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5) Nell'elenco a discesa Formato, selezionare una delle seguenti opzioni:

• PDF
• XLS (Excel)
• DOC (Word)
• XLSX

6) Fare clic su sull'icona Anteprima rapporto. Successivamente viene
visualizzato il rapporto nel formato di output scelto.

6.3 Come inviare immediatamente il rapporto tramite e-mail

Prerequisiti

È stato configurato un account di posta elettronica per l'invio di rapporti. 

Il proprio indirizzo e-mail è configurato nel sistema di comunicazione.

I prefissi per numeri di telefono esterni sono stati configurati.

Passo a passo

1) Fare clic su Gestione pianificazione.
2) In Gestione rapporti, nel gruppo rapporti corrispondente, fare clic sul

modello di rapporto desiderato.
3) Utilizzando i parametri rapporto, definire il periodo di tempo e l'argomento

su cui dovrà essere basato il rapporto.

Suggerimento:  I parametri rapporto dipendono dal
modello di rapporto scelto. Per informazioni sui vari
parametri rapporto, consultare la sezione Rapporti alla
pagina 16.

4) Fare clic su OK, quindi di nuovo su OK.
5) Nell'elenco a discesa Formato, selezionare una delle seguenti opzioni:

• PDF
• XLS (Excel)
• DOC (Word)
• XLSX

6) Fare clic sull'icona Inviare file rapporto in allegato.
7) Nel campo A inserire l'indirizzo e-mail del destinatario desiderato.
8) Se lo si desidera, è possibile inserire testo aggiuntivo nella riga dell'oggetto

utilizzando il campo Oggetto.

Suggerimento:  L'oggetto dell'e-mail inizia sempre con il
cognome dell'utente e il relativo indirizzo e-mail configurato
nel sistema di comunicazione.

9) Nel campo Messaggio inserire il messaggio di testo per l'e-mail.
10) Fare clic su Invia, quindi di nuovo su OK.

Attività correlate
Come configurare i prefissi per i numeri di telefono esterni alla pagina 36
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6.4 Come aggiungere modelli di rapporto

Prerequisiti

È disponibile un nuovo modello di rapporto (file di tipo .rptdesign). 

Passo a passo

1) Fare clic su Gestione rapporti.
2) Fare clic sull'icona Seleziona file.
3) Nella finestra di selezione del file, selezionare il file desiderato, quindi fare

clic su Apri.
4) Selezionare una delle seguenti opzioni:

• Se si desidera salvare il modello di rapporto in un gruppo rapporti
esistente, selezionare il gruppo desiderato nell'elenco a discesa.

• Se si desidera salvare il modello di rapporto in un nuovo gruppo,
nell'elenco a discesa selezionare la voce Nuovo gruppo di rapporti.
Sostituire la voce Nuovo gruppo di rapporti nell'elenco a discesa con il
nome del nuovo gruppo di rapporti.

5) Fare clic sul simbolo più (+) e quindi su OK.

6.5 Come eliminare i modelli di rapporto

Prerequisiti

È stato eseguito l'accesso a myReports con lo stesso nome utente con il quale
era stato aggiunto il modello di rapporto. 

Il modello di rapporto non è contenuto in alcuna pianificazione.

Passo a passo

1) Fare clic su Gestione rapporti.
2) Nell'elenco a discesa dei gruppi di rapporti, selezionare il gruppo di rapporti

desiderato.
3) Nell'elenco dei modelli di rapporto, fare clic sul modello desiderato.
4) Fare clic sull'icona Elimina rapporto, quindi su OK.
5) Fare clic su OK.

6.6 Come aggiornare i modelli di rapporto predefiniti

Prerequisiti

Accedere a myReports come amministratore di myReports. 

Passo a passo

1) Fare clic su Amministrazione > Rapporti predefiniti.

Nota:  Aggiornando i rapporti predefiniti, tutte le pianificazioni
vengono eliminate.

2) Per confermare, fare clic su OK.
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Passaggi successivi

myReports si spegne automaticamente e si riavvia.

Concetti correlati
Modelli di rapporti predefiniti alla pagina 18

A31003-P3030-U129-03-7219, 05/2024
22 myReports, Manuale d'uso



Pianificazioni

7 Pianificazioni
Una pianificazione definisce la creazione programmata nel tempo di un rapporto
specifico.

Nome pianificazione

Il nome di una pianificazione viene definito in base al nome del rapporto
contenuto seguito dall'ID della pianificazione.

Parametri rapporto

Prima della creazione di un rapporto, definire, utilizzando i parametri rapporto,
il periodo di tempo (data, ora) e l'argomento (agenti, code d'attesa, ecc.) su cui
dovrà essere basato il rapporto.

Periodo dell'esecuzione

È possibile configurare i seguenti momenti per l'esecuzione della pianificazione:

• Data inizio

La pianificazione verrà eseguita a partire dalla data di inizio.
• Data fine

Al raggiungimento della data di fine dell'intervallo configurato, l'esecuzione
della pianificazione viene ripetuta.

• Ora

La pianificazione viene eseguita per la prima volta all'orario qui specificato.

Nel caso alla stessa ora vengano eseguite più pianificazioni, per motivi legati
alle prestazioni, i relativi rapporti verranno generati a intervalli di un minuto
ciascuno. Questo non ha alcun effetto sul contenuto dei rapporti.

Metodo di output

Per l'output di un rapporto pianificato sono disponibili le seguenti opzioni:

• Messa a disposizione tramite e-mail 

I rapporti programmati nel tempo possono essere inoltrati al proprio indirizzo
e-mail oppure all'indirizzo e-mail di altri destinatari. A tal fine è necessario
che sia stato configurato un account di posta elettronica per l'invio di
rapporti.

L'indirizzo e-mail di un destinatario può essere inserito manualmente oppure
selezionato da un elenco a discesa. L'elenco a discesa include tutti gli
utenti interni del sistema di comunicazione per i quali è stato configurato un
indirizzo e-mail.

• Esportazione di rapporti 

I rapporti pianificati possono essere memorizzati sul server applicazioni e/o
memorizzati su un PC o un server collegati alla rete.

Frequenza

Per l'esecuzione di una pianificazione, è possibile configurare i seguenti tipi di
frequenza, sulla base dell'ora specificata per la prima esecuzione:

• Oraria
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• Giornaliero
• Ogni n giorni
• Settimanalmente
• Ogni n settimane
• Mensilmente
• Ogni n mesi
• Annualmente

Gestione pianificazione

Nota:  Se il rapporto pianificato dovrà basarsi sui dati di un
periodo di tempo specifico, tale intervallo temporale deve
essere indicato nei parametri del report. I rapporti pianificati
comprendono sempre i dati dalla data e ora iniziale (ora Da/data
Da) alla data e ora finale (ora A/Data A).

Gestione pianificazione consente la creazione di pianificazioni e contiene le
seguenti icone:

Icona Funzione

Elimina pianificazione

Modifica pianificazione

Salva pianificazione

Anteprima rapporto

Inviare file rapporto in allegato

Le mie pianificazioni

Le mie pianificazioni consente la gestione delle proprie pianificazioni e mostra
un elenco con i seguenti dettagli:

• Identificatore
• Nome pianificazione

È possibile visualizzare solo le proprie pianificazioni.
• Inizio pianificazione

Inizio del periodo in cui verrà eseguita la pianificazione.
• Fine pianificazione

Fine del periodo in cui verrà eseguita la pianificazione.
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• Frequenza

Modalità e intervallo di frequenza.

È possibile ordinare le pianificazioni in base ai valori alfanumerici di una
qualsiasi colonna, in ordine crescente o decrescente. La sezione Le mie
pianificazioni contiene inoltre le seguenti icone:

Icona Funzione

Elimina pianificazione

Modifica pianificazione

Visualizza dettagli

mostra le seguenti informazioni su:

• Orario per la prima esecuzione
• Formato di output
• Se applicabile: indirizzo e-mail del destinatario
• Se applicabile: altri dettagli sulla frequenza

Concetti correlati
Elementi dell'interfaccia utente alla pagina 7
Rapporti alla pagina 16

7.1 Come aggiungere pianificazioni

Prerequisiti

È stato configurato un account di posta elettronica per l'invio di rapporti. 

È stato configurato un modello e-mail.

I dati per l'esportazione dei rapporti sono stati configurati.

I prefissi per numeri di telefono esterni sono stati configurati.

Passo a passo

1) Fare clic su Gestione pianificazione.
2) In Gestione rapporti, nel gruppo rapporti corrispondente, fare clic sul

modello di rapporto desiderato.
3) Utilizzando i parametri rapporto, definire il periodo di tempo e l'argomento

su cui dovrà essere basato il rapporto.

Suggerimento:  I parametri rapporto dipendono dal
modello di rapporto scelto. Per informazioni sui vari
parametri rapporto, consultare la sezione Rapporti alla
pagina 16.

4) Fare clic su OK, quindi di nuovo su OK.
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5) Nell'elenco a discesa Pianificazioni per il rapporto selezionato,
selezionare la voce Nuova pianificazione.

6) Nel campo Inizio pianificazione inserire la data di inizio per l'esecuzione
della pianificazione o fare clic sulle icone calendario adiacenti e
selezionare la data di inizio desiderata dal calendario.

7) Nel campo Fine pianificazione inserire la data di fine per l'esecuzione
della pianificazione o fare clic nelle icone calendario adiacenti e
selezionare la data di fine desiderata dal calendario.

8) Nella casella di riepilogo Esegui questa operazione pianificata,
selezionare l'ora di esecuzione della pianificazione.

9) Nell'elenco a discesa Formato, selezionare una delle seguenti opzioni:

• PDF
• XLS (Excel)
• DOC (Word)
• XLSX

Nota:  Se il rapporto selezionato contiene grafici o
immagini, l'opzione XLSX è disponibile. I grafici e le
immagini vengono visualizzati solo in formato xlsx. Per
visualizzare le tabelle è preferibile l'opzione XLS.

10) Selezionare la casella di controllo Frequenza.
11) Per l'intervallo di frequenza, selezionare una delle seguenti possibilità

nonché, se necessario, altri dettagli:

• Frequenza oraria
• Ripetizione giornaliera
• Ripetizione settimanale
• Ripetizione mensile
• Ripetizione annuale

12) Selezionare una delle seguenti opzioni per il metodo di output:

• Se si desidera esportare rapporti, selezionare l'opzione Esporta
rapporto.

• Se si desidera inviare i rapporti tramite e-mail, procedere come segue:

Selezionare l'opzione Invia il rapporto all'indirizzo e-mail utente.
Fare clic sull'icona della lente di ingrandimento per definire l'indirizzo
o gli indirizzi e-mail di invio dei rapporti. Viene visualizzata la finestra
Destinatari e-mail. Sono disponibili le seguenti opzioni:

– Se si desidera inviare il rapporto al proprio indirizzo e-mail configurato
nel sistema di comunicazione, selezionare la casella di controllo
accanto al nome.

– Se si desidera inviare i rapporti a un utente interno del sistema di
comunicazione, selezionare l'utente desiderato nell'elenco a discesa,
fare clic sull'icona del segno più per acquisire la voce nell'elenco dei
destinatari e-mail.

Ripetere l'operazione se si desidera inviare i rapporti ad altri utenti
interni.
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– Se si desidera inserire manualmente l'indirizzo e-mail di un
destinatario, inserirlo nel campo di input. Fare clic sull'icona del segno
più per acquisire l'indirizzo nell'elenco dei destinatari e-mail.

Ripetere l'operazione se si desidera immettere manualmente altri
indirizzi e-mail.

L'oggetto dell'e-mail contiene il nome della pianificazione. Il
nome del file esportato, allegato all'e-mail, contiene la data e l'ora
dell'esportazione.

Fare clic su OK.
13) Fare clic sull'icona Salva pianificazione. Successivamente vengono

visualizzati i dati della nuova pianificazione.
14) Fare clic su Salva.

Attività correlate
Come configurare un modello e-mail in formato testo alla pagina 31
Come configurare un modello e-mail in formato HTML alla pagina 32
Come configurare i prefissi per i numeri di telefono esterni alla pagina 36

7.2 Come visualizzare i dettagli di una pianificazione

Passo a passo

1) Fare clic su Le mie pianificazioni. 
2) Nell'elenco a discesa, selezionare il gruppo rapporti corrispondente o la voce

(Tutti i rapporti).
3) Fare clic sulla pianificazione desiderata.
4) Fare clic su sull'icona Visualizza dettagli.
5) Fare clic su OK.

7.3 Come modificare la pianificazione

Passo a passo

1) Fare clic su Le mie pianificazioni. 
2) Nell'elenco a discesa, selezionare il gruppo rapporti corrispondente o la

voce (Tutti i rapporti).
3) Fare clic sulla pianificazione desiderata.
4) Fare clic sull'icona Modifica pianificazione.
5) Se si desidera modificare i parametri rapporto, fare clic sull'icona

Parametri rapporto. Modificare i parametri rapporto desiderati.

Suggerimento:  I parametri rapporto dipendono dal
modello di rapporto scelto. Per informazioni sui vari
parametri rapporto, consultare la sezione Rapporti alla
pagina 16.

Fare clic su OK, quindi di nuovo su OK.
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6) Se si desidera modificare la data di inizio, nel campo Inizio pianificazione
inserire la data di inizio per l'esecuzione della pianificazione o fare clic sulle
icone calendario adiacenti e selezionare la data di inizio desiderata dal
calendario.

7) Se si desidera modificare la data di fine, nel campo Fine pianificazione
inserire la data di fine per l'esecuzione della pianificazione o fare clic nelle
icone calendario adiacenti e selezionare la data di fine desiderata dal
calendario.

8) Se si desidera modificare l'ora di esecuzione della pianificazione, nella
casella di riepilogo Esegui questa operazione pianificata, selezionare
l'ora di esecuzione della pianificazione.

9) Se si desidera modificare il formato di output, nell'elenco a discesa
Formato, selezionare una delle seguenti opzioni:

• PDF
• XLS (Excel)
• DOC (Word)
• XLSX

10) Se si desidera modificare l'intervallo di frequenza, selezionare una delle
seguenti opzioni per l'intervallo di frequenza, nonché, se necessario, altri
dettagli:

• Frequenza oraria
• Ripetizione giornaliera
• Ripetizione settimanale
• Ripetizione mensile
• Ripetizione annuale

11) Se si desidera modificare il metodo di output, selezionare una delle
seguenti opzioni:

• Se si desidera esportare rapporti, selezionare l'opzione Esporta
rapporto.

• Se si desidera inviare i rapporti tramite e-mail, procedere come segue:

Attivare l'opzione Invia il rapporto all'indirizzo e-mail utente Fare
clic sull'icona della lente di ingrandimento per definire l'indirizzo o
gli indirizzi e-mail di invio dei rapporti. Viene visualizzata la finestra
Destinatari e-mail. Sono disponibili le seguenti opzioni:

– Se si desidera inviare il rapporto al proprio indirizzo e-mail configurato
nel sistema di comunicazione, selezionare la casella di controllo
accanto al nome.

– Se si desidera inviare i rapporti a un utente interno del sistema di
comunicazione, selezionare l'utente desiderato nell'elenco a discesa,
fare clic sull'icona del segno più per acquisire la voce nell'elenco dei
destinatari e-mail.

Ripetere l'operazione se si desidera inviare i rapporti ad altri utenti
interni.
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– Se si desidera inserire manualmente l'indirizzo e-mail di un
destinatario, inserirlo nel campo di input. Fare clic sull'icona del segno
più per acquisire l'indirizzo nell'elenco dei destinatari e-mail.

Ripetere l'operazione se si desidera immettere manualmente altri
indirizzi e-mail.

Fare clic su OK.
12) Fare clic sull'icona Salva pianificazione. Successivamente vengono

visualizzati i dati della pianificazione elaborata.
13) Fare clic su Salva.

7.4 Come eliminare le pianificazioni

Passo a passo

1) Fare clic su Le mie pianificazioni. 
2) Nell'elenco a discesa, selezionare il gruppo rapporti corrispondente o la voce

(Tutti i rapporti).
3) Fare clic sulla pianificazione da cancellare.
4) Fare clic sull'icona Elimina pianificazione, quindi su OK.
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8 Configurazione
È possibile personalizzare myReports in base alle proprie esigenze. In questo
si osservi che diverse funzioni possono essere eseguite esclusivamente
dall'amministratore di myReports.

8.1 Configurazione tramite un utente di myReports

Un utente di myReports può configurare myReports in base alle proprie
necessità mediante le seguenti impostazioni.

Lingua dell'interfaccia utente

Selezionare la lingua dell'interfaccia utente. 

Colori dell'interfaccia utente

Selezionare il colore per l'interfaccia utente.

Modello e-mail

Suggerimento:  Per la configurazione del modello e-mail è
necessaria l'immissione della password di amministratore.

Nel modello e-mail è possibile configurare l'oggetto e il testo del messaggio
per tutte le e-mail da utilizzare per l'invio di rapporti mediante myReports. Per il
modello e-mail, è possibile utilizzare i seguenti formati:

• Corpo
• HTML
Nel modello e-mail del formato testo è possibile utilizzare i seguenti
segnaposto:

Segnaposto Significato

{1} Nome rapporto

{2} Inviato da

Per impostazione predefinita è disponibile il seguente modello e-mail del
formato testo in inglese:

Oggetto: Business report – {1}

Messaggio: Dear recipient(s),

This is the scheduled report: {1}.

Regards

{2}

Indirizzo del server

È possibile modificare l'indirizzo del server (indirizzo IP).
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Nota:  Modificare l'indirizzo del server solo su istruzione
dell'amministratore del proprio sistema di comunicazione.
Se l'indirizzo del server è errato, non sarà possibile utilizzare
myReports.

8.1.1 Come modificare la lingua dell'interfaccia utente

Passo a passo

1) Fare clic su Amministrazione > Impostazioni myReports. 
2) Nell'elenco a discesa Lingua selezionare la lingua desiderata.
3) Fare clic su Salva.
4) Fare clic su File > Disconnetti. Viene visualizzata la finestra di

registrazione.
5) Accedere al sistema (vedere Come avviare myReports alla pagina 11, dal

punto 2).

8.1.2 Come modificare i colori interfaccia utente

Passo a passo

1) Fare clic su Amministrazione > Impostazioni myReports. 
2) Selezionare il pulsante di opzione del tema desiderato.
3) Fare clic su Salva.
4) Fare clic su File > Disconnetti. Viene visualizzata la finestra di

registrazione.
5) Accedere al sistema (vedere Come avviare myReports alla pagina 11, dal

punto 2).

8.1.3 Come configurare un modello e-mail in formato testo

Prerequisiti

La password amministratore è nota all'utente. 

Passo a passo

1) Fare clic su Amministrazione > Modello e-mail.
2) Immettere la password di amministratore e fare clic su OK.

Suggerimento:  Per impostazione predefinita la password
amministratore è reports.

3) Nel campo Oggetto digitare il testo desiderato.
4) Nel campo Messaggio digitare il testo desiderato.
5) Fare clic su Salva e quindi su Annulla.

Attività correlate
Come aggiungere pianificazioni alla pagina 25
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8.1.4 Come configurare un modello e-mail in formato HTML

Prerequisiti

È disponibile il corrispondente file HTML (*.htm o *.html). 

La password amministratore è nota all'utente.

Passo a passo

1) Fare clic su Amministrazione > Modello e-mail.
2) Immettere la password di amministratore e fare clic su OK.

Suggerimento:  Per impostazione predefinita la password
amministratore è reports.

3) Fare clic sull'icona Apri messaggio HTML.
4) Nella finestra di selezione del file, selezionare il file desiderato, quindi fare

clic su Apri.
5) Fare clic su Salva e quindi su Annulla.

Attività correlate
Come aggiungere pianificazioni alla pagina 25

8.1.5 Come modificare l'indirizzo del server

Prerequisiti

myReports è stato avviato. 

È disponibile un nuovo indirizzo del server (indirizzo IP).

Nota:  Modificare l'indirizzo del server solo su istruzione
dell'amministratore del proprio sistema di comunicazione.
Se l'indirizzo del server è errato, non sarà possibile utilizzare
myReports.

Passo a passo

1) Fare clic su File > Disconnetti. Viene visualizzata la finestra di
registrazione.

2) Se non viene visualizzato il proprio nome utente, immetterlo nel campo
Nome utente.

3) Se non viene visualizzata la propria password, immetterla nel campo
Password.

4) Se in futuro si desidera utilizzare la funzione di registrazione automatica in
myReports, selezionare la casella di controllo Salva password. La finestra
di registrazione non verrà più visualizzata in futuro. Sarà sempre possibile
modificare successivamente questa opzione, vedere Come disattivare la
registrazione automatica alla pagina 12.

Nota:  Utilizzare la registrazione automatica solo se è
possibile escludere che altre persone abbiano accesso al
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proprio account Windows. In caso contrario, tali persone
potrebbero accedere ai vostri messaggi vocali o fax o
deviare il vostro numero di telefono su destinazioni esterne a
pagamento.

5) Nel campo IP server immettere il nuovo indirizzo IP.
6) Fare clic su Connetti.

8.2 Configuration by the myReports Administrator

As a myReports administrator, you can configure myReports via the following
settings:

Password amministratore

Changing the password for the myReports administrator. The default login
name is Administrator, and the default password is reports.

Suggerimento:  The administrator of your communication
system can reset the administrator password via the WBM.

Prefixes for External Phone Numbers

In order to enable myReports to handle different types of connections (for
example, international calls or calls from mobile phones), you must configure
the appropriate prefixes for external call numbers.

The following prefixes for external phone numbers can be configured:

Type Esempi Considered in the
following predefined report

templates (examples)

Internazionale 00 Chiamate in entrata (Internazionale) -
Per utente

Chiamate in uscita (Internazionale) -
Per utente

Cellulare 14;15;16 Chiamate in entrata (Cellulare) - Per
utente

Chiamate in uscita (Cellulare) - Per
utente

Chiamata
gratuita

0800 Incoming Calls (Free-Calls) - Per
User

Chiamate in uscita (Chiamate
gratuite) - Per utente

Chiamata a
pagamento

0900;0901 Chiamate in uscita (Chiamate a
pagamento) - Per utente
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Type Esempi Considered in the
following predefined report

templates (examples)

Call to special
phone numbers

01;123 Chiamate in entrata (Chiamate
specifiche) - Per utente

Chiamate in uscita (Chiamate
specifiche) - Per utente

Data Protection

You can enable Data Protection. This causes the last four digits of of the phone
numbers (CLI column) to be replaced by **** in all reports involved. This also
applies to reports that are created with myAgent.

Esportazione di rapporti

You can configure the storage location for exporting scheduled reports.

I rapporti pianificati possono essere memorizzati sul server applicazioni e/o
memorizzati su un PC o un server collegati alla rete.

Lingue

Suggerimento: In order to configure the languages, you will
need to enter a special password. 

By default, several different languages are available for the user interface
and report templates of myReports. To customize myReports for your specific
requirements, you can:

• Add languages for the user interface and report templates. You can do this in
the following ways:

– Import texts of the new language via a CSV file

The texts of the new language must be available as a CSV file in the
format shown in the following example. Note that only one language can
be imported at a time, and that the texts of this language must always
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be in the third column, next to the English language. In the following
example, the language Svenska (Swedish) can be imported.

Due to the import, the language table is extended by one column.
– Translate texts for the new language using Google Translator

The language table is extended by one column and populated with
suggested translations for the new language from Google Translator.
These suggested translations are based on the standard texts of the
English user interface and report templates.

– Enter texts for the new language manually

The language table is extended by an empty column, and you can enter
the texts for the new language in the empty cells.

You can edit the text in any cell of the language table by simply double-
clicking on that cell.

By selecting Edit > Find and Replace, you can also find any term in the
language table and replace it with some other term.

• Delete languages of the user interface and report templates.

If you do not want a particular language of the UI to be made available to the
myReports users, you can simply delete that language.

• Save the language texts of the user interface and report templates in a CSV
file.

You can save the current language texts of all languages in a CSV file.

Default Languages

Suggerimento:  In order to reset the languages (Default
Language Setup), you will need to enter a special password.

You can reset (reinitialize) the languages of the user interface and report
templates to repair or restore a missing language, for example.

A reset results in a restart of myReports. Following the restart, all the default
languages will available again to all the myReports users.
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8.2.1 Come modificare la password amministratore

Prerequisiti

Accedere a myReports come amministratore di myReports. 

Passo a passo

1) Fare clic su Amministrazione > Gestione.
2) Nel campo Password amministratore inserire la password amministratore

attualmente in uso.
3) Nei campi Nuova password e Immetti nuovamente password, inserire la

nuova password amministratore.
4) Fare clic su Salva.

8.2.2 Come configurare i prefissi per i numeri di telefono esterni

Prerequisiti

Accedere a myReports come amministratore di myReports.

Passo a passo

1) Fare clic su Amministrazione > Numeri di telefono.
2) Nel campo Internazionale digitare uno o più prefissi per i numeri di telefono

internazionali.

Suggerimento:  Per aggiungere più prefissi in uno stesso
campo, separarli con ",", ";", "-", ".", "_" o "|".

Una volta salvati, i prefissi presentano il carattere separatore
";" indipendentemente dal carattere separatore che era stato
immesso dall'utente.

3) Nel campo Cellulare digitare uno o più prefissi per i numeri di cellulare
nazionali.

4) Nel campo Chiamata gratuita digitare uno o più prefissi per i numeri verdi.
5) Nel campo Chiamata a pagamento digitare uno o più prefissi per i numeri di

telefono a pagamento.
6) Nel campo Chiamata specifica digitare uno o più prefissi per i numeri di

telefono speciali.
7) Fare clic su Salva.

Attività correlate
Come inviare immediatamente il rapporto tramite e-mail alla pagina 20
Come aggiungere pianificazioni alla pagina 25

8.2.3 Come attivare/disattivare la protezione dei dati

Prerequisiti

Accedere a myReports come amministratore di myReports.
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Passo a passo

1) Fare clic su Amministrazione > Protezione dei dati. 
2) Selezionare una delle seguenti opzioni:

• Per attivare la protezione dei dati, selezionare la casella di controllo
Frammentazione CLI.

Nei relativi rapporti le ultime quattro cifre del numero di telefono (colonna
CLI) vengono sostituite da ****.

• Per disattivare la protezione dei dati, deselezionare la casella di controllo
Frammentazione CLI.

In tutti i relativi rapporti, vengono mostrati i numeri di telefono completi
(colonna CLI).

3) Fare clic su Salva.

8.2.4 Come configurare il percorso per l'esportazione dei rapporti
pianificati

Prerequisiti

Accedere a myReports come amministratore di myReports.

Passo a passo

1) Fare clic su Amministrazione > Esporta rapporto. 
2) Se i rapporti pianificati devono essere salvati sul server applicazioni,

selezionare la casella di controllo Abilita esportazione.
a) Nel campo Directory di sistema inserire il percorso in cui dovranno

essere memorizzati i rapporti pianificati.

Il percorso di archiviazione predefinito è /var/reports.
3) Se i rapporti pianificati devono essere salvati in un PC o in un server della

rete, selezionare la casella di controllo Abilita esportazione remota.
a) Nel campo Host remoto inserire l'indirizzo IP dei PC o server collegati

alla rete nei quali verranno salvati i rapporti pianificati.
b) Nel campo Porta remota inserire la porta dei PC o server collegati alla

rete che saranno utilizzati per l'esportazione.
c) Nel campo Nome utente, inserire il nome dell'utente per l'accesso

al PC o al server di rete. Nel caso in cui il dominio sia richiesto dalla
destinazione, inserire Dominio;Nome utente.

d) Nel campo Password, inserire la password per l'accesso al PC o al
server di rete.

e) Nel campo Directory remota inserire il percorso (cartella/cartella
secondaria/../..) in cui dovranno essere memorizzati i rapporti pianificati.

f) Selezionare uno dei seguenti protocolli per l'esportazione:

– Se si desidera utilizzare il protocollo SMB (Server Message Block)
o CIFS (Common Internet File System), nell'elenco a discesa
Protocollo, selezionare la voce SMB/CIFS.
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– Se si desidera utilizzare il protocollo SFTP (Secure File Transfer
Protocol), nell'elenco a discesa Protocollo, selezionare la voce
SFTP.

Nota:  Per garantire l'esportazione remota, il protocollo
qui selezionato deve essere supportato anche dai PC o
dai server sulla rete.

Può essere necessario abilitare le porte utilizzate
per l'esportazione nel server o nel PC di rete. Per
impostazione predefinita, sono utilizzate la porta 22 (con
il protocollo SFTP) e la porta 445 (con i protocolli SMB/
CIFS).

4) Fare clic su Salva.

8.2.5 Come aggiungere una nuova lingua per l'interfaccia utente e i
modelli di rapporti

Prerequisiti

È nota la password per la configurazione della lingua.

I testi lingua attuali dell'interfaccia utente e dei modelli di rapporti sono stati
salvati in un file CSV (vedere Come esportare i testi lingua dell'interfaccia
utente e dei modelli di rapporti  alla pagina 40).

I testi della nuova lingua sono disponibili oppure noti (per i testi della nuova
lingua da creare manualmente o tradurre tramite Google Translator).

È disponibile il file CSV (per i testi della nuova lingua da importare tramite un file
CSV).

Passo a passo

1) Fare clic su Start  > Programmi > Communications Client > myReports.
Al termine verrà visualizzata la finestra di registrazione.

2) Nel campo Nome utente inserire Amministratore.
3) Nel campo Password immettere la password per la configurazione della

lingua. Per chiarimenti rivolgersi all'amministratore del proprio sistema di
comunicazione.

4) Inserire nel campo IP server l'indirizzo IP del proprio server applicazioni,
se questo non viene già visualizzato.

5) Fare clic su Connetti.
6) Fare clic su Amministrazione > Impostazione lingua. Viene visualizzata

una tabella con i testi dell'interfaccia utente e i modelli di rapporti nelle
lingue attualmente disponibili.
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7) Selezionare una delle seguenti opzioni per aggiungere la nuova lingua per
l'interfaccia utente e i modelli di rapporti:

• Se si desidera importare i testi della nuova lingua mediante un file CSV,
procedere nel modo seguente:

Fare clic su File > Importa da CSV.

Nell'elenco a discesa Nuova lingua selezionare la nuova lingua, quindi
fare clic su Sfoglia. Accedere al percorso di memorizzazione del file
CSV desiderato, quindi fare clic su Apri. Al termine la tabella sarà
ampliata di una colonna e i campi di input della nuova lingua saranno
compilati con il contenuto del file CSV.

Fare clic su Salva.

Fare clic su OK, quindi su Annulla.
• Se si desidera tradurre i testi della nuova lingua mediante Google

Translator, procedere nel modo seguente:

Nell'elenco a discesa Nuova lingua selezionare la nuova lingua
desiderata.

Selezionare la casella di controllo Usa GOOGLE Translator.

Fare clic sull'icona del segno più. Al termine la tabella sarà ampliata di
una colonna e compilata con le proposte fornite da Google Translator.
Questi suggerimenti si basano su testi standard dell'interfaccia utente e
dei modelli di rapporti inglesi.

Verificare le proposte e, se necessario, correggerle e completarle.

Fare clic su Salva.

Fare clic su OK, quindi su Annulla.
• Se si desidera registrare manualmente i testi della nuova lingua,

procedere nel modo seguente:

Nell'elenco a discesa Nuova lingua selezionare la nuova lingua
desiderata.

Deselezionare la casella di controllo Usa GOOGLE Translator.

Fare clic sull'icona del segno più. Al termine la tabella sarà ampliata di
una colonna.

Immettere i testi della nuova lingua nei campi di input corrispondenti.

Fare clic su Salva.

Fare clic su OK, quindi su Annulla.
8) Se si desidera utilizzare la nuova lingua come lingua predefinita,

nell'elenco a discesa Lingua predefinita, selezionare la nuova lingua.
9) Fare clic su OK.
10) Fare clic su Chiudi.

8.2.6 Come cancellare una lingua dell'interfaccia utente e dei modelli di
rapporti

Prerequisiti

È nota la password per la configurazione della lingua.
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I testi lingua attuali di tutte le lingue dell'interfaccia utente e dei modelli di
rapporti sono stati salvati in un file CSV (vedere Come esportare i testi lingua
dell'interfaccia utente e dei modelli di rapporti  alla pagina 40).

Passo a passo

1) Fare clic su Start  > Programmi > Communications Client > myReports.
Al termine verrà visualizzata la finestra di registrazione.

2) Nel campo Nome utente inserire Amministratore.
3) Nel campo Password immettere la password per la configurazione della

lingua. Per chiarimenti rivolgersi all'amministratore del proprio sistema di
comunicazione.

4) Inserire nel campo IP server l'indirizzo IP del proprio server applicazioni,
se questo non viene già visualizzato.

5) Fare clic su Connetti.
6) Fare clic su Amministrazione > Impostazione lingua. Viene visualizzata

una tabella con i testi dell'interfaccia utente e i modelli di rapporti nelle
lingue attualmente disponibili.

7) Nell'elenco a discesa Elimina lingua selezionare la lingua desiderata.
8) Fare clic sull'icona del cestino e quindi su OK.
9) Fare clic su Salva.
10) Fare clic su OK, quindi su Annulla.
11) Fare clic su Chiudi.

8.2.7 Come esportare i testi lingua dell'interfaccia utente e dei modelli di
rapporti

Prerequisiti

È nota la password per la configurazione della lingua.

Passo a passo

1) Fare clic su Start  > Programmi > Communications Client > myReports.
Al termine verrà visualizzata la finestra di registrazione. 

2) Nel campo Nome utente inserire Amministratore.
3) Nel campo Password immettere la password per la configurazione della

lingua. Per chiarimenti rivolgersi all'amministratore del proprio sistema di
comunicazione.

4) Inserire nel campo IP server l'indirizzo IP del proprio server applicazioni, se
questo non viene già visualizzato.

5) Fare clic su Connetti.
6) Fare clic su Amministrazione > Impostazione lingua. Viene visualizzata

una tabella con i testi dell'interfaccia utente e i modelli di rapporti nelle lingue
attualmente disponibili.

7) Fare clic su File > Esporta in CSV. Al termine nell'Editor verrà visualizzato il
contenuto del file CSV myReports-Languages.csv.

8) Salvare il file CSV nella rubrica desiderata e chiudere il file.
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9) Fare clic su Chiudi.

8.2.8 Come resettare tutte le lingue dell'interfaccia utente e dei modelli di
rapporti

Prerequisiti

È nota la password per la configurazione della lingua predefinita.

I testi lingua attuali dell'interfaccia utente e dei modelli di rapporti sono stati
salvati in un file CSV (vedere Come esportare i testi lingua dell'interfaccia
utente e dei modelli di rapporti  alla pagina 40).

Passo a passo

1) Fare clic su Start  > Programmi > Communications Client > myReports.
Al termine verrà visualizzata la finestra di registrazione.

2) Nel campo Nome utente inserire Amministratore.
3) Nel campo Password immettere la password per la configurazione della

lingua. Per chiarimenti rivolgersi all'amministratore del proprio sistema di
comunicazione.

4) Inserire nel campo IP server l'indirizzo IP del proprio server applicazioni, se
questo non viene già visualizzato.

5) Fare clic su Connetti.
6) Fare clic su Amministrazione > Configurazione lingua predefinita.

Nota:  La funzione Configurazione lingua predefinita
consente di resettare la lingua dell'interfaccia utente
e dei modelli di rapporti (inizializzazione). In tal caso
per l'interfaccia utente e i modelli di report saranno a
disposizione solo le lingue predefinite.

7) Fare clic su OK. Successivamente myReports esegue un riavvio.

Passaggi successivi

Accedere a myReports ed eventualmente aggiungere altre lingue per
l'interfaccia utente e i modelli di rapporti (vedere Come aggiungere una nuova
lingua per l'interfaccia utente e i modelli di rapporti  alla pagina 38).
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9 Appendice
In Appendice vengono fornite informazioni sulle diverse funzioni utente, sulle
relative differenze, nonché sulle tabelle del database disponibili in myReports.

9.1 myReports User Roles

myReports dispone di una propria gestione degli utenti che controlla l'accesso
alle funzioni di MyReports assegnando ruoli agli utenti. In questo modo è
possibile distinguere tra utenti di myReports (utenti standard) e amministratori di
myReports.

Your current user role is set when you log into myReports. 

• Logging in as a myReports user: 

– Nome utente: This is usually your station number.
– Password: The default password is 1234.

• Logging in as a myReports administrator: 

– Nome utente: The login name is Administrator.
– Password (Administrator Password): The default password is reports.

Le differenze tra le diverse funzioni utente sono riassunte nella seguente
tabella.

Funzione utentemyReports:

Attività myReports

Users

myReports

Amministratore

Rapporti

Anteprima rapporto X X

Inviare immediatamente il rapporto
tramite e-mail

X X

Aggiungere modelli di rapporto X X

Eliminazione dei modelli di rapporto
aggiunti

X X

Aggiornare i modelli di rapporto
predefiniti

X

Pianificazioni

Aggiungere pianificazioni X X

Visualizzare i dettagli di una
pianificazione

X X

Modifica pianificazione X X

Elimina pianificazione X X

Configuration

Modificare la lingua dell'interfaccia
utente

X X

Modificare i colori interfaccia utente X X
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Funzione utentemyReports:

Attività myReports

Users

myReports

Amministratore

Configurare il modello e-mail X1 X

Modificare l'indirizzo del server X X

Modificare la password
amministratore

X

Configurazione dei prefissi per i
numeri di telefono esterni

X

Come attivare/disattivare la
protezione dei dati

X

Come configurare il percorso per
l'esportazione dei rapporti pianificati

X

Add or delete language X2

Reset languages X2

1 The administrator password must be entered to configure the e-mail template
2 In order to add or delete a language and reset all languages, you will need to log in as a myReports

administrator with a special password.
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